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Offline Sorter Change Log v4.3.1 
(Last Updated 8/02/17)

Improvements: 
 Support for Nex 5.1 files with 64-bit timestamps and float samples 

 Licensing updates

Bug Fixes:
 Fix bug in loading long-duration pl2 files with timestamps > 32 bits

 Fix bug in loading .NEV files with both spike and continuous data

 Fix bug in Export as New PL2 with disabled trodal channels

 Fix bug that allowed Matlab import menu items to enable when Matlab was not available on the system

Offline Sorter Change Log v4.3.0 
(Last Updated 3/21/17)

New Features: 
 Added ability to do channel mapping with .pl2 files.

 Added ability to Export Per-Waveform Data into a different file per time segment. Note that when multiple .pl2 files have 
been imported (or an .omf file), this allows an output file to be written for each original input file (if the default of creating a 
new time segment per file was chosen).

 New Threshold Scan view to show the per-threshold SNR and waveform count values numerically. Added signal and noise 
standard deviations (in microvolts) to the display.

 New Calculate SNR tool that allows SNR calculations from existing spikes, taking into account invalidated and sorted/
unsorted spikes.

 New Center Timeline on a Time feature allows entering in a time and the Timeline window will center itself displaying that 
time.

 For importing .nex files, it is now possible to control whether the unit designation is obtained by parsing the Nex Variable 
name, from the UnitNumber field in Nex Variables, or is always set to unsorted.

Improvements:
 Many operations that process or export spikes for all channels are now much faster. This is because OFS now assumes 

that the spike counts for a channel are correct regardless of whether the channel has been loaded or not. For obscure cases 
where the spike counts may not be correct after the file is initially loaded, there is a new Tools -> Verify Channel Counts that 
will load all channels, one by one. This then guarantees that all counts are correct for all channels.

 Sped up many operations that loop over all channels by disabling display updates during the processing.

 The progress bar shown on the bottom during long operations now generally gives a better indication of the true amount 
of progress.

 If errors occur during a batch operation, the error messages are now much more likely to be present in the batch log file.

 Scan Graph view now has a toolbar.

 The MATLAB continuous data importer can now handle data stored in integer formats.

 Channel mappings for Sources can be loaded in without disturbing the existing channel mappings for Sources not 
present in the file.
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Bug Fixes:
 The Davies-Bouldin sort quality metric was not being calculated correctly

 The Blackrock native loader left the channel count at the maximum (unless the Remove Empty Channels option was 
specified), now it limits to the last channel with non-zero counts.

 Fixed a bug when using the non-default file save behavior for .pl2 files that caused renaming to fail.

 Fixed a bug that could happen when a .plx file with more than 4 units was loaded then immediately exported to NEX.

 Fix bug that mistakenly disabled menu items for several operations that can be performed when no channel has been 
loaded, e.g. performing automatic sorting on all channels.

 Fix bug where saving a TPL file would complain when empty channels were not sorted with a template or contour sorting 
method.

 Fix bug where setting waveform length from batch stopped working.

 Fix bug with clicking on an empty Overlaps Analysis view.

 Fix bug in loading pl2 files when the first electrode in a stereotrode/tetrode channel was disabled.

 Fix bugs that could cause nonsense waveforms to appear in a disabled electrode for stereotrode/tetrode data.

 Fix continuity problem with filtering across continuous data buffer boundaries.

 Fix problem with calculating SNR that caused the ratio to be too low (some samples that were signal were counted as 
noise).

 Fixed redraw problem after using interval selection to invalidate waveforms.

 Fix bug where .plx export would skip the entire channel if first electrode was not present.

Offline Sorter Change Log v4.2.0 
(Last Updated 8/31/16)

New Features:
 Overlap analysis for tetrodes, along with a new display showing unit shifts in the Overlaps Analysis View.

 �Added an optional “noise unit” to overlaps analysis to potentially rescue unit firings that appear late in the waveform 
window because they were triggered by some random noise instead of a different unit firing.

 �For Export to .PLX, .PL2®, and .NEX, the user now has full control over which Sources are exported. This includes the ability 
prevent certain spike Sources from being exported to .PLX, which was not previously possible.

 Added a new Select Waveform dialog that allows choosing a specific waveform for display.

 �Support for importing HDF5-based file format from 3-Brain.

Improvements:
 �In Overlaps Analysis, shifted templates that match (to within the template tolerance) any other unit are now disqualified. 
This greatly reduces “false positive” overlaps.

 �In Overlaps Analysis, don’t draw the flat line when the shift template does not cross threshold, or is not relevant to  
the “noise unit” analysis.

 �Allowed extraction of longer waveforms, up to 896 samples.

 �Improved initial seed point selection for E-M sorting algorithms.

 �Added a unit label and improved performance of Waveform Inspection view.

 �The format of the Source selection grid has been made consistent between the Export to .PLX/.PL2/.NEX dialogs and  
the Sources View.

 �Shift left-click pan and Shift right-click zoom in the Timeline and Rasters Views.

 �Mouse-wheel zoom in Continuous Frequency Spectrum View.

 �Show number of channels explicitly in Sources view.

 �New batch command to invalidated unsorted waveforms on each channel.

 �Perform automatic sorting dialog now allows setting more items, with spin controls, and 
remembers whether 2D or 3D feature space was selected.
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 �Went to a more sensible order for the items in the Control Grid.

Bug Fixes:
 �Fixed issue where for some graphics cards (usually Intel-based cards) the waveforms view would not erase properly.

 �Fixed issue where hitting the delete key would put grids into an odd state.

 �Fixed bug loading very large Blackrock nsX files.

 �Fix bug in Rasters View that could crash when continuous data was present on a spike channel. 

 �Fixed bug that left the Timeline View in a strange state after reloading a saved layout or a Reset to Default Layout.

 �Fixed bug that could crash if the Continuous Frequency Spectrum View was showing when a temporary continuous Source 
association was made.

 �Fixed problem with View Only Selected Time Segment behavior.

 �Fixed issue with Feature vs Feature showing tetrode modes when current channel is single-electrode.

 �Fixed issue when resetting range and zoom from Feature vs Feature view.

 �Fixed bug with changing trodality in Channel Map view.

 �Fixed bug where applying a filter would not update the peak heights histogram, which could cause auto-thresholding  
to set a bad threshold on the current channel.
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Offline Sorter v4.1.0
New Features:
 Support for loading spike and continuous data from MATLAB®.

 Support for .NEX5 NeuroExplorer® format, including a new ExportToNex5 batch command.

 Reinstated the native loader for Blackrock/Cyberkinetics files, and added support for continuous data.

 Export Per-Unit Data can now export several of the per-Waveform quantities calculated on the unit template waveforms.

 �Added the ability to limit the waveforms used for PCA to those in the currently-selected unit. This is sometimes useful for 
emphasizing substructure within a unit. Note that using this setting is ‘temporary’ in the sense that changing the channel 
will revert the PCA calculation to the Use All Valid setting again.

 �New batch commands allow doing low-pass filtering and setting sort start/end from batch.

 �New feature (on by default) to simplify drawn contours by reducing the number of line segments in them before using 
them. This can greatly speed up operations involving drawn contours, especially when there are large numbers of spikes, 
but it can be slightly less precise in that the inside/outside determination of a few points around the edges of the contour 
may be different.

 �The template fit tolerance is no longer limited to integer values. Non-integer values can be entered into the fit tolerance 
spin boxes and used to get finer control of the template matching, but the non-integer fit tolerance values cannot be 
saved into .PLX or .TPL files.

 �Added a Stop button to the Perform Automatic Sorting dialog.

 �Doing Remove Waveforms (or Remove All Waveforms Except) while the unsorted unit is selected will remove the  
selected waveforms from all units.

Improvements:
 �Advanced statistics are no longer recalculated during animated sorting, even if they are enabled. Sorting goes much  
faster now by default, but it is no longer possible to watch the sort quality metrics evolve as the sorting progresses.

 �Since computing per-Unit L-Ratio and Isolation Distance sort quality metrics can take a long time (especially with large 
numbers of waveforms), the calculation of these quantities is now disabled by default, which again speeds up sorting.  
If the user is interested in these metrics, they can be enabled on the Tools->Options->Stats options screen.

 �The default Outlier Threshold is now 2.0 instead of 1.3.

 �Added a toolbar button to bring up the Recalculate PCA dialog.

 �Increased the maximum samples per waveform to 224, fixed the check to complain if waveforms longer than this are 
encountered.

 �Changed the way that the Neuroshare loader determines the gap structure for continuous data channels, which should  
be faster in many cases.

 �Made the Neuroshare loader more tolerant of bad voltage range specifications in data files. This improved the ability  
to load data from certain vendors (e.g. Alpha Omega). 

 �Batch processing is now smarter about not loading continuous channels if there have been no batch commands  
specified for continuous data, which improves performance.

 �Digital referencing now supports stereotrode/tetrode data.

 �Miscellaneous speed and memory-usage improvements throughout.

 �When Time Segments are generated automatically to cover a file, the end and begin times are now separated by one 
timestamp. This allows exporting the segments as non-overlapping intervals to recent versions of NeuroExplorer.

Bug Fixes:
 �Fixed issue with crossing waveforms when the spike digitization frequency is not the same  
as the timestamp frequency.

 Fix issue with disabled continuous channels from PL2 files still showing up.

 Fixed problem with Events when loading multiple PL2 files.

 �Fixed bug affecting the Neuroshare and Neuralynx loaders when different Sources  
with the same sampling frequency should have been created.

 Fixed bug with extracting spikes from slowly-varying continuous data. 

 Stopping sorting now also stops scan sorting methods, and sorting all channels.
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 Scrolling all the way to the right on the Raster View could corrupt the time range.

 �The Automatic Sorting dialog no longer re-does the last sort that was done by pressing Apply after the user presses  
OK, unless something was changed within the dialog to necessitate re-sorting.

 Fixed the quick viewpoint ‘jump’ in 3D windows that happened when the mouse button was first pressed to circle points.

 Fixed bug where the Timeline View could remain blank following a Scan.

 Event sources are no longer listed in the Export to PL2 dialog – event Sources are always exported.

 Changing channels while sorting is in progress is no longer allowed.

 �Fixed bug with creating a new unit from the selected waveform in the Timeline View when there were no units  
already in existence.

Offline Sorter v4.0

New Features:
 Ability to load multiple .PL2 files simultaneously.

 Added digital referencing.

 Added Overlaps Analysis view which performs overlapping waveform analysis.

 �Time Segments can now be named and individually colored and toggled on/off, and can be saved/restored as 
NeuroExplorer Intervals. The Interval Selection tool can now create Time Segments.

 Added Signal-to-Noise ratio computation.

 �New Threshold Scan Graph view which allows examining Signal-to-Noise and number of spikes as a function of threshold  
position for continuous data.

 Added new L-Ratio and Isolation Distance sort quality metrics.

 Added support for Bands and Lines sorting methods.

 �Ability to display arbitrary (compatible) combinations of continuous and spike data for a channel together in the Timeline  
view. This replaces the need to associate channels during loading of .PLX files or during channel remapping.

 Ability to apply high-cut filtering to continuous channels.

 New Scan modes which include the ability to scan using different random initial seed clusters.

 Ability to use standard deviation or MAD to calculate fit tolerances or band fit tolerances.

 Support for multiple spike Sources.

 The contents of the Sort Summary view are customizable.

Improvements:
 Sort Start and Sort End are per-Source.

 Tooltips now on graph views.

 Improved options to show 3D and Normalized per-segment statistics on Time Segments view.

 Now performs digital gain compensation when different electrodes in sterotrode/tetrode .PLX files have different gains.

 Batch command DetectMicrovolts now allows specifying constant voltage thresholds.

 Improved the appearance of the Surface view.

 �The native MultiChannel Systems importer now handles the “digital” stream. It also includes a toggle to use native or 
Neuroshare DLLs to import .MCS data files.

 In Waveforms view, Timeline view, or Waveform Detection view the mouse wheel now controls the voltage Zoom.

 The Create Separate Events for all Strobe Codes feature now applies to .PL2 files.

 More tools can now do all channels in a Source.

 Find Units tooltip now indicates which sorting method will be applied.



www.plexon.com
Page 7

Bug Fixes:
 Fixed bug to where one can now print the Waveforms view with Ctrl-P.

 �Fixed bug where unrecognized batch command errors in batch files were not being reported to the user. They were  
just silently ignored. Fixing this bug may cause existing batch files to complain about syntax errors if the wrong  
characters were used to ‘comment out’ files. Comment lines should start with ‘//’ characters.

Obsoleted Features:
 Support for .PLX0 and .DDT files.

 Optimize .PLX file.

 Native versions of loaders for vendor file formats that now have Neuroshare DLLs available.

 Update .EXP file with Sort Info.

 Create Events at unit firing times.

Offline Sorter v3.3.5

Bug Fixes:
 �Fixed crash (introduced in 3.3.4) that happened during extraction of spikes from continuous data.

Offline Sorter v3.3.4

Bug Fixes:
 �Fixed crash that could happen when digital events were being shown in the Timeline view.

 Fixed bug where center selected in Timeline view would no longer change displayed time range.

 Fixed bug to where creating multiple time segments now works again.

 Fixed incorrect �Free Memory display in toolbar.

 Fixed bug where export to New PLX could produce illegal .PLX files when the original file was a .NEX file.

Offline Sorter v3.3.3

General:
 �This is the last release that supports Windows® XP. The next release will only be provided for Windows 7.

New Features:
 �New Tetrode Min/Max display available in Feature vs Feature view - shows both the Peak and the Valley feature for each 
electrode permutation.

 �Now Exports to .PL2 files from batch.

 �Introduced Event Sources for .PL2 files.

 �Rewrote the Channel Map view to be per-Source. Also, the (confusing) ability to remap channels using droplists has been 
replaced with writing/editing/reading a channel mapping (.OFM) file. The format of the .OFM changed to be per-Source.

 �Spike + Continuous channels are no longer associated on import. Instead, arbitrary continuous channels can be displayed 
with any spike channel.

 �New convenience toolbar buttons for selecting which waveforms to show (unsorted, current unit, current segment).

Improvements:
 �Introduced concept of a current Source. Changing the channel changes the current Source.

 �Can now select which continuous Sources to Export to NeuroExplorer.

 �When exporting unit/channel/waveform data from batch, output files now have a  
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double extension to better indicate which kind of export they contain.

 �Streamlined support for other file formats; dropped native loaders for CED and Cyberkinetics files (these files can still be 
loaded into Offline Sorter™ via Neuroshare).

 �Removed option to pre-load spikes (it was obsolete - spikes were being preloaded anyway).

 �Specifying a time range in batch via Set TimeRangeStart/End now affects continuous and events as well as spikes.

 �Can now translate environment variables in batch file arguments, using the %VAR_NAME% syntax.

 �Now supports non-integer gains.

 �Restoring a scan sorting (e.g. from human-supervised sorting procedure) now also restores the initial sorting best choice.

 �Can now remove short ISI waveforms from units for multiple channels via Tools -> Remove Short ISI Waveforms.

Bug Fixes:
 �Fixed bug where Offline Sorter could get confused on the waveform length when dealing with trodal .PL2 files.

 �Fixed problem with sampling frequency when importing newer .NEV files.

 �Fixed issue with typing threshold values in Timeline view.

 �Fixed issue with very large timestamps in Neuralynx files.

 �Fixed issues with exporting from multi-Source .PL2 to .PLX files.

 �Fixed display issue when some Sources were stereotrode/tetrode and some were not.

 �Fixed problem with temp directory when starting Offline Sorter with command line arguments.

 �Fixed bug where Waveforms views would no longer show invalidated waveforms in some cases.

 �Fixed bugs with slightly-off alignment between spikes and continuous in Timeline view.

Offline Sorter v3.3.2

New Features:
 �Combined many Sorting menu options into new Automatic Sorting and Template Sorting dialogs.

Improvements:
 �Better behavior when the hard drive fills up during writing, but users should still avoid letting the hard drive fill up  
during writing.

 �Now keeps track of the reprocessing and acquisition comments separately for .PL2 files, allow editing PL2 comments.

 �Removed the (broken) ability to associate file extensions from the Help -> About box.

 �Faster selection of waveforms from Cluster view.

 �Sources view is now shown by default.

 �Operations that allowed processing All Channels now allow users to select a Source instead.

 �Raw Src/Channel numbers are now shown in a new column in the Channel Parameters view.

Bug Fixes:
 �Fixed issue with loading continuous data from .NEX files.

 �Fixed issue with .PL2 files containing 12-bit data (converted from older .PLX files).

 �Fixed isse where we removed the dangerous ability to customize the main menu. It could cause newly-added menu items 
to not appear until the user performed a Window->Customization->Reset of the menu bar.

 �Fixed bug that prevented opening a file from the command line, or after associating the .PLX file extension with Offline 
Sorter and double-clicking on a .PLX file.

 �Fixed bug with saving .PLX0 files.

 �Fixed bug where Offline Sorter would crash if the Feature Space droplists were removed from the Feature Space 
toolbar.

 �Fixed bug that allowed batch files to set a preamp gain of 0.

 �Fixed bug where Export to .PL2 would ask the user to select a .PLX file.
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 �Fixed an issue where Sources created during extraction did not have  
channel numbers starting at 1.

Offline Sorter v3.3.1 

New Features:
 �Can now Export to .PL2 files.

Improvements:
 �Set initial spike channel gain to be the same as continuous gain for .PLX files - makes future spike extraction easier.

 �Offline Sorter now reports raw channel numbers for .PL2 files that are 1-based.

 �Zoom in/out in Z for 3D Cluster view no longer reversed as compared to X and Y.

Bug Fixes:
 �Fixed bug where batch command ‘Set ContPreampGain’ did not properly adjust total continuous gain.

 �Fixed bug where Offline Sorter allowed changing trodality or remapping channels in .PL2 files. This was never supported, 
but Offline Sorter allowed doing it through the user interface, with somewhat disastrous results.

 �Fixed a hesitation when highlighting waveforms in the 3D Cluster view.

 �Fixed crash when clicking on empty lines at the end of the Channel Map view.

 �Fixed complaint about licensing when starting a batch command file without first doing anything else in Offline Sorter.

 �Fixed issue with Saving .PL2 files after invalidating waveforms.

 �Fixed an issue with reading very old tetrode .PLX files.

 �Fixed crash in Offline Sorter 32bit when clicking in Waveform Detection view with discontinuous data selected.

Offline Sorter v3.3.0

New Features:
 �Can now load and save .PL2 files.

 �Added alignment during waveform extraction.

 �Added Enhanced PCA, and an Apply button to the Tools -> Recalculate PCA dialog.

 �Added mouse wheel zooming to 2D Cluster view and Feature vs. Feature view.

 �Added zooming by middle mouse click/drag to 2D Cluster view and Feature vs. Feature view.

 �Added zooming to a time range in the Timeline view using the middle mouse button.

 �Added ability to define Time Segments interactively in the Timeline view via the right click menu.

 �Added ability to invalidate waveforms in the current segment via Timeline view right click menu.

 �Added control over the placement of the Offline Sorter temporary cache directory, and the ability to clean it.

 �Added a tool to invalidate high-amplitude artifacts.

 �Rewrote the Waveforms view for much faster rendering of large numbers of waveforms. The previous Waveforms view is 
available under the ‘View - Waveforms (Legacy)’ menu.

Improvements:
 �Added more info to Sources view.

 �Nicer pagination when printing the Sort Summary view.

 �Made the Timeline view less cluttered by moving some functions to other windows.

 �Added right click menu in Units view to re-sort using templates and (new) tolerances.

 �Added ability to enabled dual threshold extraction from batch via Set DetectSigmas2.

 �Can now use Time Segments for Interval Selection.

 �Added ability to turn Deferred Waveform Drawing on/off from the right click  
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menus of the affected view.

 �Prevented some unneeded redraws - some cases should be faster to render now.

 �CED native importer now warns for file versions that it cannot handle instead of crashing.

 �Prevented unneeded re-reading of files during Export to .NEX in some cases.

 �Can now set a fixed initial zoom (instead of auto-zooming each channel), and added an option to  
preferentially use spikes instead of continuous data in auto zoom calculation.

 �Increased the maximum number of channels to 4096 in 64-bit version only.

 �No longer overwrites Acquisition Software in header when exporting to .PLX.

Bug Fixes:
 �Fixed bug where filtered continuous data could be clipped as if it had 12-bit samples.

 �Fixed bug that caused crashes whenever the Control Grid was closed.

 �Fixed bug in Axion loader that did not display correct Continuous channels.

 �Fixed bug in Axion loader that caused .PLX files exported from Axion data to be invalid.

 �Fixed where we improved memory allocation to prevent 32-bit Offline Sorter from running 
out of memory for high channel count files.

 �Fixed bug that only happened for complicated channel remappings for .PLX files.

 �Fixed bug where sometimes the Segments view would not repopulate correctly after loading a new file.

 �Fixed bug where Control Grid channel list was blank when Control Panel view is shown manually after application start.

 �Fixed bug so that it can now handle reading in .NEX files that were saved from Offline Sorter without saving the  
unsorted waveforms.

 �Fixed bug where state of the Continuously Trigger check box no longer persisted (its state not saved/restored when you 
exist/re-open Offline Sorter). The Continuously Trigger check box will now always be unchecked when you start OFS.

 �Fixed bug where deleting all spikes on all channels because of a change to waveform lengths could crash.

 �Fixed bug that could crash when doing a scan and 0 units were found.

 �Fixed bug where selecting sort method in menu would not select the sort method in the Control Panel droplist.

 �Fixed issue with setting threshold while Deferred Waveform Drawing is on.

 Fixed issue in which Control Grid values did not update properly after a Reset to Defaults.

 �Fixed bug in nsn loader that could result in zero amplitude spikes.

 �Fixed issues with loading CED tetrode data and Cyberkinetics files via the Neuroshare loader.

 �Fixed update issues in the binary import dialog.

Offline Sorter v3.2.4

New Features:
 �Can now load Axion files.

Improvements:
 �When changing spike length/prethreshold in a file for which spikes already exist, the option is now available to erase all 
existing spikes.

 Will now show the drop-arrow on droplists all the time instead of just when the droplist has focus.

 Now allows the use of time segments to limit the export of data to new .PLX and .NEX files.

 �When exporting to .NEX or to a new .PLX, the time range limits can now affect continuous and event data as well  
as spikes.

 �Changed Neuroshare loader to make it more general.

Bug Fixes:
 �Fixed bug where Values for FWHM that were once expressed in units of clock ticks, are now  
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expressed in milliseconds.

 �Fixed glitch that would cause a solid line to be rendered from where  
continuous data ended to the end of the file.

Offline Sorter v3.2.3

New Features:
 �Waveforms can no longer be selected by clicking in the Waveforms view.

 �The Adjust Gains tool can now automatically set optimal gains for spike extraction (new Optimize button).

Improvements:
 �Added ability to continuously trigger spikes from continuous data.

 �Added new waveform feature to calculate the average.

 �Added ability to invalidate waveforms outside of intervals read from a file.

 �Fixed issues with Create Time Segments and made it easier to use this feature to get functionality equivalent to the older 
Use Range feature (by creating one segment).

 �Default directory for saving .TPL files is same as the data file directory.

 �Added ExportToTPL and SetContinueSort batch commands.

Bug Fixes:
 �Fixed bug where Unit labels exported to MATLAB during export per-unit data were off by one.

 Fixed bug by cleaning up some displays that could show stale views when filed was changed.

 �Fixed bugs associated with converting continuous data to tetrodes when each channel did not have the exact same 
number of samples.

 �Fixed bugs that only occurred in 64-bit version with large spike counts.

 �Fixed bug in Sources view channel ranges for unusual file configurations.

Offline Sorter v3.2.2

New Features:
 �Added Redo button.

 �Added Stop Sort button.

 �Added Recalculate All Stats button in stats panes.

 Added Adaptive template tool.

Improvements:
 �Now has nicer behavior for ‘shifted-in’ values at the waveform edges during waveform alignment.

 �Adaptive templates are now handled by undo.

Bug Fixes:
 �Fixed problem with exporting not yet loaded channels in ‘Export to New .PLX’.

 �Fixed .PLX files with gaps in channel numbers.

 Added fix for changing trodality of Continuous Only data files.

 �Fixed minor bugs with menus not graying out appropriately.

 �Fixed bug with picking in Cluster vs. Time view.

 �Added fix so Toggling stats options forces recalc/redraw.

 �Added fix to reset the sort width to full-range after waveform extraction.

 �Fixed crash with continuous-only Datawave files.



www.plexon.com
Page 12

 �Fixed issue with remove short ISI waveforms from batch.

 �Fixed bug with Adaptive template sorting.
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Offline Sorter v3.2.1

Bug Fixes:
 �Fixed issue that could scramble the loading of tetrode .PLX files.

 �Fixed crash issue when making individual events out of strobes when loading .PLX and Neuralynx files.

 �Fixed batch problem that can cause processing of the first channel to fail under unusual circumstances.

Offline Sorter v3.2.0

New Features:
 �Added new native .NEX loader that can combine .NEX waveform variables for a channel.

 �Added new Sources Info view to display the Source structure of loaded files.

 �Added ability to disable calculation of per-segment statistics to save time if not using  
segment-related views.

Improvements:
 �Improved low-cut filtering options for continuous data.

 �Improved large-file handling, faster channel load times.

 �Better handling of Sources from .PLX files written by OmniPlex®.

 �New batch commands for setting filtering options and preamp gains.

Bug Fixes:
 �Fixed problem with settings getting saved/restored before/after batch runs when the current directory was  
changed during the batch operation.

 �Fixed problem with sorting extracted spikes when applying a .TPL file to .DDT data.

 �Fixed problem with Overwrite file save behavior and Neuralynx files.

 �Fixed problem with invalidated waveforms being saved to Neuralynx files with an invalid unit number of -1.

 �Fixed problem when spike streams with 0 spikes in them were encountered while loading MCS files.

 �Fixed problem with multiple spike sources in MCS files.

 �Fixed crash issue by disallowing remapping assignment of spike channels to continuous channels (any remapping  
can still be accomplished by assigning continuous channels to spike channels).

 �Fixed issue with unit tolerances not getting imported properly from .TPL files.

 �Fixed issue with invoking PLX0 conversion using Offline Sorter command line options.

 �Fixed ability to keep showing sorting contours after the initial sort.

Offline Sorter v3.1.0

New Features:
 �Added support for .PLX file format version 107, which includes support for large channel counts.

 �Added control of the directory for output files.

 �Added the Set OutputDir batch command.

Improvements:
 �Box sorting boxes are now saved/restored to .TPL files.

 �Scan files saved during batch now named for the saved output file instead of the input file.

 �Improvements to batch syntax and reporting.

Bug Fixes:
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 �Fixed crash problem that occurred if the Control Grid window was closed.

 �Fixed problem with saving/restoring custom key assignments.

 �Fixed problem where remapping a .PLX file to stereotrode/tetrode would result in extra copies of the events.

 �Fixed potential problem with loading strobed events from .NEV, .NLX and Neuroshare files.

 �Fixed bug to where Export as PLX now writes out the modified spike threshold resulting from re-thresholding.

 �Fixed bug to where files with 16-bit waveform data now use the non-MAP fit tolerance for template sorting, ignoring the 
Use MAP-Compatible Fit Tolerance setting.

 �Fixed issue with invalidating waveforms for file formats where the timestamp frequency is not the same as the waveform 
digitization frequency.

 �Fixed potential issue with SortEnd not being properly read in from trodal .PLX files.

 �Fixed issue with the full-scale voltage edit box on the Timeline view not being updated after a waveform extraction.

 �Fixed problem with exporting to .PLX when file containing only continuous channels was imported from certain formats.

 �Fixed issues with handling gains/voltages from MCS files.

Offline Sorter v3.0.1

Bug Fixes:
 �Fixed issues with exporting upsampled continuous data to NeuroExplorer.

 �Fixed bug to where Export functions are now compatible with latest releases of MATLAB.

 �Fixed bug to where you can no longer circle clusters when in box sorting mode.

 �Fixed issues with events during ‘Export to New .PLX’ when data was read in from Neuroshare.

Offline Sorter v3.0.0

New Features:
 �Time Segments – The Select Time Segment function has now been replaced by the much more extensive ability to divide 
the file into time segments, with support for viewing and using only a specific segment in all operations. Added an option 
to automatically create time segments when loading a file.

 �Added a new Clusters vs. Time view that shows how clusters evolve as a function of time.

 �Added Sort Quality vs. Time Segment Graph view to display how sort quality changed through the file.

Improvements:
 MATLAB export functions now work with MATLAB R2009a.

 Sorting Changes 
   - Added ability to sort with Adaptive template.

   - Added Box sorting.

   - Added a new Templates vs. Time view to display how the template adapted through the file.

   - �Added ability to quickly save and recall sortings for a channel, which is useful for comparisons.

   - �Added a new Scan Graph view that graphically displays the contents of the Scan view.

   - �Scan results can now be saved to and loaded from .SCAN files. A new option exists to automatically load the  
companion .SCAN file for each channel as it is loaded. Together with the new batch scan commands, this  
enables a useful mode of operation where you set up a batch Offline Sorter job to do sorting scans all  
night, then manually review the  sorting and choose the most appealing sort for each channel.

   - �Added new sorting methods based on scanning a parameter and picking the best sort  
according to a selected sort quality metric.
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  Continuous Data Handling 
    - �Added upsampling with linear or spline interpolation.

    - Can now (optionally) save upsampled and filtered continuous data in the ‘Export to New .PLX’ operation.

    - �Added an FFT (Fast Fourier Transform) view to show the frequency spectrum of continuous data.

    - �Waveform detection/extraction will now appropriately treat differences in voltage scales between waveform and 
continuous data.

    - �The Channel Parameters and File Summary view now show more information related to gains and voltage ranges.  
The Channel Parameters view allows modification of the continuous or spike channel gains if they are not correct  
in the data file, and there is a new Adjust Gains tool.

  General UI Changes 
    - A new user interface toolkit is now used, which provides for added flexibility and customizability.

    - �The buttons on the Waveform and Cluster view have now been turned into toolbars.

    - �The bottom Timeline view has now been enhanced so that it can show continuous and waveform data simultaneously 
with a resizable splitter. The controls have been simplified, and added an option to show dots at the sample locations  
for continuous data.

    - The Contours and Waveform Crossing sorting methods have now been combined into one, and this sorting method is  
      always in effect no matter which other sorting method you have selected. Crossing in the Waveforms view is now  
      symmetrical with circling in the Cluster view for all operations.

    - �The views showing Waveform or Continuous Data now show the time and voltage corresponding to the mouse  
position in the status bar.

    - �Now the currently selected Unit is always drawn on top in the Waveforms view.

    - �New Select main menu item to select the Next/Previous Channel, Unit, Waveform, or Segment.

    - The electrode enable checkboxes have now moved into the Control Grid.

    - �New Run menu allows easily starting other applications from within Offline Sorter.

  General Changes 
    - ��Performance enhancements for loading data files.

    - Batch enhancements.

      • New commands for scanning.

      • Added a menu item to edit batch files with a user-selected editor.

      • Offline Sorter remembers previous batch file locations.

      • New Quick Batch Reference now showing all batch commands.

      • Added a menu item to show the log file resulting from the last batch run.

    - There are new options to automatically load the first channel after opening a new file (on by default), and to automatic    
     load companion scan results.

    - The following features have been deprecated:

      • 3D Phase Space view.

      • The Sort toolbar.

      • The ‘Show 0 to scroll pos’ feature of the Waveform display.

      • The ability to time-magnify just the spikes (without zooming the time range) in the Waveform display.

      • The Control Cluster display and Control Waveform display are no longer independent. It is just Control Displays now.

    - Added options for handling sort start/end imported from .PLX files.

    - �Can now save and restore all Offline Sorter options and settings to/from a file, and reset all  
options to factory defaults.

    - �Dumping PowerPoint® slides now creates the output .PPT file in the data directory  
to work around a file protection issue in Vista®.

    - �Now available as a true 64-bit executable.



www.plexon.com
Page 16

Offline Sorter v2.8.8

Improvements:
 �Can now save Neuralynx files.

 �Now handles 16-bit Neuralynx files.

 �Now new batch command ‘ForEachFile InvalidateArtifactsAfter’ which does the same artifact removal as ‘ForEachFile 
InvalidateArtifacts’, except it does it after the processing loop over all channels, has finished. This is useful for invalidating 
artifacts after waveform detection was done on all channels.

 �Made the invalidation of incomplete tetrode waveforms an option, so that tetrode data collected with disabled electrodes 
can now be more easily loaded.

 �Can now select a unit to export when exporting waveform data, added the ability to write out raw channel numbers and 
channel names (to text only).

 �Dumping PowerPoint slides now creates the output .PPT file in the data directory, to work around a file protection issue 
in Vista.

Bug Fixes:
 �Fixed regression introduced in v2.8.7 that broke the loading of tetrode .DDT files.

 �Fixed bug where batch command Set FilterFreq did not allow setting a frequency of 500Hz, even though it is valid.

 �Fixed bug where setting a filter frequency in batch did not apply correctly to subsequent waveform extraction.

 �Fixed potential hang bug with calculating PCA with disabled electrodes for tetrode data.

 �Fixed bug when exporting waveform data to excel when not exporting every waveform.

 �Fixed bug where batch tetrode waveform extraction only set the threshold on the first electrode.

Offline Sorter v2.8.7
NOTE: This version of Offline Sorter REQUIRES that the new v7.4.0 of the Sentinel drivers be installed. The installer for 
Offline Sorter will run the Sentinel installer that will upgrade the Sentinel drivers to v7.4.0. Do not cancel out of this Sentinel 
installation, or Offline Sorter will not unlock. After the installation, the Sentinel installer will be in the Common subdirectory 
named Sentinel Protection Installer 7.4.0.exe, it can be executed from there.

Improvements:
 �Cleaned up ‘Export to New .PLX’ and Export to .NEX dialogs, remembered their last-used settings, and now the ‘Max 
Waveform Count Exceeded’ dialog will no longer come up during these operations.

 �Added an option that will optionally persist the View Waveform settings in the Control Grid between invocations of Offline 
Sorter. Be careful when using this, it can easily lead to blank displays.

 �In the Waveform view, now when a slice line falls directly on top of a sort start/end line and you click on it to move it, you 
will grab the slice line unless you click near the top/bottom triangles for the sort start/end lines, in which case you will grab 
the sort start/end lines.

 �Added right-click menus to the Waveform display and the Cluster display, it brings up the Waveforms and Units main 
menus respectively.

 �Made dialogs more consistent.

 �Added a ‘ForEachChannelKeepWfsOutsideSpan’ batch command.

Bug Fixes:
 �Fixed a problem that could scramble channel numbers for .DDT files with disabled channels.

 Fixed the problem where v2.8.6 would not unlock if you were logged into a licensed system via remote desktop.

 �Fixed a problem that can result in bad unit counts in the header of exported .PLX files whenever there is a non-
simple mapping between channel offsets and channel numbers, which can happen when the ‘Remove Empty 
Spike Channels’ data import option is selected. The header counts being off is a minor error that does 
not affect reading the file in Offline Sorter or NeuroExplorer, and it can be repaired in PlexUtil.

 �Fixed potential crash when importing tetrode .NLX files.
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 �Fixed spurious warning when importing some .SMR files.

Offline Sorter v2.8.6
NOTE: This version of Offline Sorter REQUIRES that the new v7.4.0 of the Sentinel drivers be installed. The installer for 
Offline Sorter will run the Sentinel installer that will upgrade the Sentinel drivers to v7.4.0. Do not cancel out of this Sentinel 
installation, or Offline Sorter will not unlock. After the installation, the Sentinel installer will be in the Common subdirectory 
named Sentinel Protection Installer 7.4.0.exe, it can be executed from there.

New Features:
 �Added ability to edit comments for .PLX files.

 �Now reads and writes version 106 .PLX files.

 �Added ability to limit ISI histograms and cross-correlograms to the time range being displayed in the Continuous  
Data view.

 �Added a new option to tie the Cluster view display range for the Timestamp feature to the displayed time range in the 
Continuous Data view.

 �Added new ISI features that can be selected as axes in the 2D or 3D feature space, which can be useful for  
analyzing bursts.

Improvements:
 �Added a new option to always have a mouse right click pull up the context menu (instead of Alt-right-click).

 �Added mouse-wheel zooming to the 3D displays.

 �MCS importer now handles files with multiple analog streams.

 �Added an optional channel name to the end of each line in an .OFM file. If present, the channel will be renamed to the 
supplied name when the .OFM file is applied.

 �Added various optimizations to increase rendering speed.

 �Changed some defaults to be more realistic.

 �Changed order of appearance of tetrode Feature vs. Feature plots to be consistent with SortClient.

Bug Fixes:
 �Fixed a possible crash when 2D Cluster view was rendering ellipses for units, which could happen following alignment.

 �Fixed an issue where dialogs would pop up during batch file execution following a SortUsingTPL batch command.

 �Fixed a problem with the auto-incrementing of .PLX0 file names for subsequent saves.

 �Fixed some cases where having incomplete tetrode waveforms (e.g. the waveform from the first electrode in the tetrode 
was missing) in .PLX files would cause problems for things like exporting to .NEX files. Also if the very last spike in a 
tetrode channel was incomplete, it was not being marked invalid.

 �Fixed problem with updating an .EXP file when more than four units were present on a channel. It now only exports the 
first four units. It also writes the .EXP in an order that makes more sense.

 �Recalculating fit tolerance for existing units now takes into account whether MAP-compatible fit tolerance is selected.

 �Fixed bug where for large .SMR files with continuous data, offsets could be introduced into the continuous data.

 �Fixed a problem in reading Neuralynx files written with Cheetah v5.

Offline Sorter v2.8.5

New Features:
 �Added new installation package for Windows® x64.

Improvements:
 �Added ‘SaveInvalidated’ and ‘SaveUnsorted’ commands (analogous to ‘SaveCont’ command) to 
further  
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control exporting to .PLX from batch files.

 �Allowed changing the feature being used in the 2x3 Tetrode display in the Feature vs. Feature view by selecting from the 
feature combo box.

 �Added an option to disable loading of Events in the native .NEV loader.

Bug Fixes:
 �Fixed bug to where the Neuroshare loader now handles gaps in continuous data (e.g. loaded from .NEX files), and also 
files whose timestamps do not start at 0.

 �Fixed bug to clean up display of multi-line comments from .PLX files.

 �Fixed some cases where loading 16-bit continuous-only non-Plexon files would result in 12-bit spikes.

 �Fixed some cases for non-Plexon file formats where timestamps generated for spikes during extraction could have the 
wrong time-base.

 �Fixed problem where sometimes the threshold slider did not match the threshold line for continuous data channels.

 �Fixed problem with auto zoom with 16-bit data.

 �Fixed problem with Neuroshare import of some .NEV files that could cause a crash when exporting to .PLX.

 Fixed bug to no longer allow doing File Save or Save-As after a channel remapping has been performed.

 �Fixed problem with saving .NEV files when spikes were invalidated.

Offline Sorter v2.8.4

New Features:
 �Added new option to interpret the fit tolerance for template sorting exactly as the MAP does. This is now the default. 
To get the behavior of previous versions, uncheck ‘Use MAP-compatible fit tolerance’ in the Sort tab of the Options 
dialog box.

 �Template sorting now honors ‘Use Only Visible’ and ‘Use Only Unsorted’ selections.

 �Rearranged some items in the options tabs.

 �For MCS import, ‘filter’ streams are now handled.

 �Added ability to export the per-sample standard deviation for each unit template during Export Per-Unit Data.

Bug Fixes:
 �Fixed bug where Offline Sorter v2.8.3 was compiled to use SSE2 instructions which do not exist on PIII and many AMD 
processors. This eliminated too many machines, so now Offline Sorter v2.8.4 is dependent only on SSE, which only 
eliminates PII machines.

 �Fixed bug where trodal continuous-only .PLX files would only show the data from the first electrode.

 �Fixed bug with old pre-version 103 .PLX files not properly setting trodalness to 1.

 �Fixed bug that when using toolbar button to initiate sorting immediately after changing values in the control panel, 
changes to values might not be put into effect for the sort.

 �Fixed bug where Surface view now shows 2D Cluster quality metrics instead of 3D.

 �Fixed issue when controlling Waveform or Cluster display when ‘Show Waveform from 0 to scroll pos’ was clicked and it 
did not work.

Offline Sorter v2.8.3

New Features:
 �Added ability to start a new unit with the selected waveform without doing a template sort.

 �Added ‘Peak to Valley Ticks’ and ‘Valley to Peak Ticks’ features.

 �Added Sqrt (Energy) feature, which can provide better separation than just Energy in many cases.

Improvements:
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 �Now uses XP themes, updated look-and-feel, miscellaneous minor user interface improvements.

 �Added progress bar when loading MED and other file formats.

 Completed miscellaneous optimizations.
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 �Enabled SSE2 instructions. This speeds up certain operations (e.g. filtering) significantly.  
	 NOTE:  This change means that Offline Sorter will no longer run on Pentium II or earlier CPUs.

 �Fixed bug where when showing only selected unit in the Cluster view, the ellipses/ellipsoids for all units are no longer 
shown.

 �After a scan in the Scan view, double-clicking on a scan result line or clicking the ‘re-sort with buttons’ will no longer initiate 
a complete re-sort of the channel, it instead will recall a saved ‘snapshot’ of the original sorting result, which is much faster.

 �Changed the way that the initial clusters are set for the T-Dist E-M algorithm. There is now an option to select either a 
circular (default) or a linear pattern (used in previous versions) of initial cluster centers. Also, only a single iteration of the 
K-Means algorithm is run, instead of letting it run to completion before starting the E-M sort.

 �The K-Means sort can now be animated.

 �Better handling during waveform extraction of the odd case where the number of bits per sample for spikes and for 
continuous data is not the same.

 �Removed confusing ‘All Unsorted Waveforms’ option for selecting the waveforms to use in PCA.

 �Once a waveform has been invalidated, its unit assignment is irrelevant.

 �Made showing the alignment report following waveform alignment optional.

	� NOTE: The ‘Feature Sets’ toolbar is no longer shown by default. It is still available, but it has to be enabled using  

Tools | Customize Toolbars… before it will appear. If you are upgrading, your saved layout will likely still contain the  

Feature Sets toolbar as before.

Bug Fixes:
 Fixed problem in which DDT loader could crash with .DDT files written by certain versions of Recorder.

 �Fixed problem in which NeuroExplorer export of continuous variables could write lots of fragments, even though there 
were no gaps in the continuous samples.

 �Fixed problem in which panasonic MED loader could crash when loading large files. The export of per-Waveform or 
per-Unit a/d values to a text file would overwrite the other quantities that were chosen for export, so that the output file 
consisted only the a/d values. Export to Excel or MATLAB was unaffected.

 Fixed problem in which DDT and generic binary loader could not load files larger than 4GB.

 �Fixed problem with undo-ability of adding a new unit via selecting a waveform as the template.

 �Fixed bug to change interpretation of single-digit years in Neuralynx files to avoid an error.

 �Fixed problem in which changing a unit assignment in Waveform Inspection view failed to update views with the change.

 �Fixed problem in which zooming/unzooming in the Z direction in the 3D Clusters view only worked if the Z was PC3.

 �Fixed problem in which exporting Events read from an .SMR file to a new .PLX file did not work properly.

 �Fixed problem in which manually selecting cluster centers for KMeans and Std EM sorting when per-electrode features 
were selected.

 �Fixed problem in which Continuous Data view could crash under some conditions if drawing was deferred.

 �Fixed problem in which changing the channel map did not reset everything and caused problems.

 �Fixed problem in which filter column of Chan Params view was always showing N/A for Spike+Cont channels from .PLX 
files, even when filtering was relevant to the spikes.

Offline Sorter v2.8.2

Improvements:
 �Added progress bar when initially opening CED files.

 �Avoided some prompting dialogs when in batch mode.

Bug Fixes:
 �Fixed bug to rewrite .PLX file saving to be able to cope with the ‘Remove empty spike channels’ option.

 �Fixed problem with preserving continuous data with ‘gaps’ in .PLX0 files.

 �Fixed possible off-by-one problem with associated spike + continuous channels in .PLX0 files.

 �Fixed bug with saving invalidated waveforms into DataWave files.
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 �Fixed bugs with exporting certain other file formats as new .PLX – specifically those that start numbering the spike 
channels at 0 instead of 1.

 �Fixed sporadic crash that could happen when the 3D view was showing and some save/export operations were done.

 �Fixed crash that could happen when trying to export a file as .NEX following exporting a file as .PLX.

 �Fixed bug that would prevent loading 128 channel .PLX or .NEV files.

 �Fixed bug that could occur when waveform detection was performed on a few (not all) channels of a continuous-only file 
and the result was exported as a new .PLX.

 �Fixed anomaly with Bionic .NEV files showing an empty channel 0.

 �Fixed bug with reading .DCF files that were larger than the buffer size.

 �Fixed bug when trying to export to NeuroExplorer with a file read in from .PLX0 format.

 �Fixed bug that left waveforms with their previous unit assignment when number of waveforms is greater than the 
waveform limit for valley seeking sorting.

Offline Sorter v2.8.1

New Features:
 �Two new command line options are supported: 
- /b batfilename – execute supplied batch command file then quit. 
- �/PLX0 inputfile – convert supplied input file to .PLX0 format then quit.

Improvements:
 �Avoided reading in empty channels in batch mode. 

 �Avoided putting up Discard Changes? message box.

Bug Fixes:
 �Fixed bug introduced in v2.8.0 concerning saving of tetrode .PLX files.

 �Fixed bug with saving certain Datawave files.

 �Fixed bug where .DDT files with disabled channels were not reading in properly.

              NOTE: The new ‘Remove empty spike channels’ option on the Data Import Options dialog 
               interferes with saving files, and by mistake, the option was set to ‘checked by defaults’ in  
               v2.8.0 the File Save and Save-As options are not greyed whenever this option is checked.  
               This will be addressed in future releases. Do not attempt to save any files that were read with  

               this option checked.

Offline Sorter v2.8.0

New Features:
 �Added support for Continuous Data in Stereotrode/Tetrode (‘trodal’) situations, including trodal spike extraction.

 �Added new Surface Plots view.

 �Data file loading completely changed – added the ability to use Neuroshare DLLs. See the manual for more details.

 �Revamped Channel Map view, added ability to load channel map from file or with batch command ‘Set ChanMap fname’.

 �Revamped binary file import, added ability to save/read import parameters from a file or with the batch command ‘Set 
ImportParameters fname’.

 �Revamped .PLX0 file handling, built in a new Export to .PLX0 feature, which can also be done via a batch file. PLX0 files 
now also handle continuous data.

 �Made the ‘Info - Channels’ and ‘Info - Chan Params’ view more consistent across all file types.

 �Added ability to apply a filter to all channels in the GUI.

 �Added options for automatically recalculating templates and template fits.

 �Added new Signed Waveform Energy waveform extraction, which can be more useful 
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than normal Waveform Energy.

 �Added new alignment option to align to first local extremum after the pre-threshold. Also moved ‘Align All Channels’ 
operation from the Tools menu to the Align Dialog.

Improvements:
 �Removed the distinction between Slow Continuous and Spike Continuous channels because it was too confusing. You can 
now extract spikes from any continuous data channel, although you may not be able to save those spikes to a .PLX file. The 
maximum number of samples per spike for extracted spikes has been increased.

 �Closed several loopholes in Export As New .PLX by rewriting it. Saving continuous data will now always re-block 
continuous data. Astute users might notice that how this function behaves with respect to saving trodal data has changed. 
It no longer saves the ‘concatenated’ waveform, as it was not possible to properly maintain spike-continuous channel 
associations using this method.

 �Revamped the default file type selection, moved it to Data Import Options General options page.

 �Print channel name is now on Sort Summary instead of just channel number (which does not always match the name).

 �Added the following batch commands: ForEachChannel, DeleteAll Units, Set DetectNPW 32, Set Detect NPre 8, Set 
DetectDead 32.

 �Added new scan mode on the Scan view to investigate how the ‘Max Waveforms to use in PCA’ setting affects the PCA.

 �Can now extract much longer waveforms in non-trodal modes.

 �Improvements to the licensing dialog to make it more obvious when multiple keys exist.

 �Added ability to customize color for invalidated waveforms.

Bug Fixes:
 �Fixed bug introduced in v2.7.2 that could cause strange PCA results but only when the ‘Max Waveforms to use in PCA’ 
setting was small ( < ~100 ).

 �Fixed problem that prevented exporting continuous data imported from a generic binary file as a new .PLX file.

 �Fixed problem in which you could not create more than 26 units via the right-click menu on the Continuous Data view.  
Can now read .PLX files with 26 units.

 �Fixed problem where continuous Neuralynx data would not be properly paged in when needed.

 �Fixed problems with scrollbar behavior in Continuous Data view.

 �Fixed bug when reading DataWave continuous data with a small continuous data buffer size.

 �Fixed some anomalies when opening files of a different type via the Recent Files menu entries.

 �Fixed bug so Right-click menu items now enable properly if Continuous Data view is undocked.

 �Fixed issues where undocked windows re-dock themselves after certain operations.

 �Fixed issue with threshold value on 16-bit .PLX files.

 �Fixed redrawing bug when resizing the floating Current Channel pane.

Offline Sorter v2.7.3

Improvements:
 �Rewrote the artifact removal algorithm.

 �Allowed for some timestamp slop when reading tetrode CED files, tally and display dropped counts.

 �Added support for importing 16-bit Neuralynx files.

 �Changed default of ‘Allow Designation of Spike Continuous Channels at Load Time’ option to true.

 �Can now handle more cases where the spike digitization frequency is not the same as the timestamp frequency 
(e.g. CED files).

Bug Fixes:
 �Fixed issue with filtering continuous data channels on CED and other file formats.

 �Fixed crash bug that could happen when attempting to export some CED files to new .PLX.
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 �Fixed issue with exporting .NEX files while in Demo mode.

 �Fixed the invalidated waveform count on the Channels Grid view which was not always updating properly.

 �Fixed bug where it now warns when saving a .TPL file where units are marked as sorted with the Contour method but no 
contour is present.

 Fixed bug where it now prevents the Export to MATLAB functions from using variable names that are illegal in MATLAB.

 �Fixed bug where the amount of RAM used to store continuous data was actually ten times the amount entered in the 
‘Channel Buffer size for continuous data (MB)’ entry of the File Import options page. This is now fixed. The default value for 
the continuous data buffer size was made ten times larger to compensate for this fix.

             **IMPORTANT NOTE** Since the Channel Buffer size value is remembered between Offline Sorter invocations, using this 
              version will only store 1/10th as much continuous data into RAM as compared to what a customer was storing before. This  
              just means that Offline Sorter will have to load continuous data from the file more often. Existing customers may want to 
              increase their specified buffer size by a factor of ten in order to get the same behavior they were getting before they  
              upgraded to this new version.

Offline Sorter v2.7.2

Improvements:
 �Rewrote the ‘Export to .PLX’ algorithm to remove the requirement that the entire file must fit in RAM. It now uses temp 
files on disk instead. It is probably slower for small files, but it makes exporting large files possible.

 �Added batch mode commands for cross-channel artifact invalidation: Set ArtifactWidth2, Set ArtifactPercentage 80, 
ForEachFile and InvalidateArtifacts along with other minor batch-related improvements.

 �Added new batch command: Set Savecont 0 to prevent Offline Sorter from saving continuous data during a ‘SaveAsPLX’ 
command.

 �Added new batch commands for filtering of continuous data: Set FilterFreq 30 and ForEachChannel Filter.

 �Added new batch commands for applying .TPL files: Set TPLFileName filename and TPL ForEachFile SortUsing TPL.

 �Does not allow filtering if sampling frequency is less than 10KHz (filtering algorithm is not suited for this).

 �Added new option to Interval Selection tool: ‘Occur outside of a time span around Event A’.

 �Save As now writes out the latest version (105) of .PLX files. Before it automatically upgraded to at least version 103, but 
left the version alone if it was >=103.

 �Eliminated do-nothing Apply button on Options dialog box.

 Added efficiency improvements in PCA calculation and Waveform view.

 �Now displays warning if cluster quality or stats display is selected on Cluster view, but ‘Calculate Advanced Stats’ 
is not enabled.

 �Does not allow ‘Max waveforms to use in PCA’ to be less than two (as the PCA will always fail in this case).

 �Prevent Pseudo-F stat display from going into scientific notation so often.

 �The importer for MCS files now imports triggers as external events.

 �The T-Dist sorting algorithm will now attempt to automatically reduce the D.O.F. multiplier if it is too large relative to the 
number of waveforms. This should only affect sorting channels with a small cluster (<~100) waveforms.

 Added new tool to recalculate template fit tolerances from the existing clusters.

 �The dot frequency display in the 2D Cluster view now responds to the Control Cluster display checkbox.

Bug Fixes:
 �Fixed problem in 3D Cluster view where the highlight box for selected waveform could be hidden behind ellipses.

 �Fixed bug with tetrode Neuralynx files.

 �Fixed bug where the ‘Set DetectSigmas’ batch command would not be parsed properly.

 �Fixed bug that could cause the pre-alignment timestamps to be exported to .NEX following a timestamp-altering 
alignment operation. Doing any sorting or other operations on the data following alignment would prevent this problem 
from occurring.

 �Fixed bug that could corrupt exported .NEX file if units had been deleted.

 �Fixed crash bug that could occur when exporting continuous data from a non-.PLX file format to a new .PLX file.
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 �Fixed potential crash bug when reading .DCF files with a small buffer size, and also a data interpretation problem for .DCF 
files that represent the data as double precision values.

 �Fixed bug when Closed view after .TPL file was applied, as they should not be open when no channel is selected.

 �Fixed bug where loading all rasters from the Rasters view could leave Deferred Drawing mode enabled.

 �Fixed bug to where dropped count is now properly reset to 0 when loading a new file.

 �Fixed bug where PCA with max number of waveforms limiting now works properly.

 �Fixed several bugs where the code checked for ‘has PCA been done on a channel?’ when it really meant ‘has this channel 
been loaded?’.

 �Fixed issues in filtering code when timestamp frequency is not the same as waveform frequency (which is never the case 
for .PLX files).

 Fixed bug where the ‘Export as new .PLX’ function could write out garbage in the unit number field of continuous data  
   blocks. This was harmless since that field is not assigned a meaning for continuous data blocks, but it was a bit  
   disconcerting to see. It is now always filled with 0s.

 �Fixed bug to where the file size is now reporting properly for MCS files in Global Info tab, and the number of waveforms in 
a file is displayed in the Channels tab.

 �The right-click operations from the bottom Continuous Data view for waveforms are now undoable.

Offline Sorter v2.7.1

Improvements:
 �Selecting Waveforms - Re-threshold… (or the equivalent selection under the Tools menu) now brings up a dialog that 
allows specifying the new threshold explicitly by typing.

Bug Fixes:
 �Fixed possible data corruption problem of tetrode data after Export to .NEX.

 �Fixed bug to where doing a normal Save operation on tetrode data after doing a timestamp-adjusting alignment operation 
is no longer allowed, as this can corrupt the output file. Use ‘Export to New .PLX’ instead.

 �Fixed problem if you clicked in the Continuous Data view at a time later than the last ExtEvent.

 �Fixed problem where strobed data read in from .NEV file would not be written during ‘Export As New .PLX’.

 Fixed issues by adding a check for improper time range specifications in the Cross-correllograms view properties.

 �Fixed bug to where the opening of a new file will now offer to save the currently-open file if it has been modified.

Offline Sorter v2.7.0

New Features:
 �Added ability to export unit template waveforms in the Export Per-Unit Data function.

 �Added support for PLX version 105 files.

 �New Waveforms - Extract menu option, which provides the ability to set thresholds in units other than percent of ADC 
range, and to run extraction on all channels.

 �Added new batch commands to support batch extraction: 

   - ForEachChannelDetect – sets up to perform waveform detection each channel.

   - Set DetectSigmas – sets the detection threshold as a number of sigmas away from the mean of the Peak Height  
     Histogram (can be negative for negative thresholds).

 �Added tool to invert waveforms.

 �Added a tool to detect and invalidate cross-channel coincident artifacts.

Improvements:
 �Changed confusing file menu entries ‘Save As New .PLX’ to ‘Export to New .PLX’, and ‘Save As .NEX’ to ‘Export to .NEX’. 
The ‘Save’ now only refers to saving out the file that was read in.
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 �Waveform extraction from PLX continuous channels is much faster now.

 �Improved error messages for parsing errors on interval files for interval selection tool.

 �Detector Options dialog now shows extraction window/prethreshold/deadtime as number of samples in addition to 
number of microseconds.

 Now have the ability to perform an auto-zoom after applying a low-cut filter to continuous data.

 Added (keyboard bindable) menu option to show/hide lines between short ISI waveform pairs.

Bug Fixes:
 Fixed bug to where the �Swap Units function now also swaps templates and template fit tolerances.

 �Fixed bug to where it no longer re-calculates templates from waveforms when a previously-loaded channel is revisited.

 �Fixed problem in which adding a new unit after deleting a unit would result in the new unit getting the old ones’ template 
fit tolerance.

 �Fixed issue whre dumping of raw Waveform value in microvolts in the Export Waveform Data option would be off by the 
Zoom factor, fixed mV -> microVolt label on radio button.

 �Fixed ability to type into threshold spin box on Continuous Data view, and can now paste threshold values into the Chan 
Params view.

 �Fixed several bugs with associating spike + continuous channels.

 �Fixed problems that happen because when there are already Spike channels present, cannot freely set a new number of 
samples per waveform; the Spike channels have already determined that.

 �Fixed update problems in Grid-based view when channels are changed.

 �Fixed problem when using ‘File - Sort Using .NEX’ on Neuralynx files.

 �Fixed problem in which doing sorting from a batch file sometimes would not work because PCA was not re-run.

 �Fixed issue with timestamp adjustment during alignment by adding correct prethreshold for Bionic .NEV file.

Offline Sorter v2.6.2

New Features:
 �Support for version 103 .DDT files.

 �Added option to import only a single Neuralynx file (as opposed to reading all files in the directory containing the 
opened file).

 �Added Tool to make Events based on times of unit firings.

 �Can now have ‘Sort All Channels’ operations only sort a subset of channels.

Improvements:
 �Gain is also now shown on Chan Params tab for most imported file formats.

 �When T-Dist sorting fails to find a solution, it no longer leaves the sorting in an intermediate state.

 �Can specify default preamp gain for old revisions of .PLX files (before preamp gain was explicitly specified in the .PLX file).

Bug Fixes:
 �Fixed problem in which spike channels in MCS files were not reading in correctly.

 �Fixed bug to where the ‘Use only unsorted’ option no longer applies when removing waveforms from a unit.

 �Fixed problem in which the voltage values for the templates in the Templates view were off by the zoom factor.

 �Fixed problem in which sorting for K-Means and Std E-M was not working when invoked from the 3D Cluster view.

Offline Sorter v2.6.1

Bug Fixes:
 �Fixed problem with spike extraction on .PLX continuous data channels  
(did not affect .DDT data files).



www.plexon.com
Page 26

 �Fixed problem where Rasters view could get stuck at very high zoom levels.

 �Fixed problem with calculated per-electrode PCA for stereotrode/tetrode data.

 �Fixed Microsoft problem that caused a ‘The parameter is incorrect’ error message when loading a file from a CDROM  
(see http://support.microsoft.com/default.aspx?scid=kb;en-us;828100).

 �Fixed problem by removing some debugging code.

Offline Sorter v2.6.0

New Features:
 �New view to show raster plots for all channels.

 �New view to view and print ISI histograms, including linear and log scaling of axes.

 �New view to view and print cross-correlograms between units in a channel.

 �New view to plot the waveform points in phase space.

 �New function to remove all except selected Waveforms from units.

 �Added ability to animate the passage of time.

 �Per-electrode enable toggles for trodal data. These toggles affect the PCA and feature value calculations for the 
concatenated waveforms, and are also used in alignment to limit where the alignment minima/maxima can be located.

 �Support for files that contain associated spike + continuous channels. Support for .PLX file format version 104, including up 
to 256 slow channels.

 �Added facility to define up to three user-defined feature space combinations. Once defined, they can be quickly put into 
effect via menu selections or toolbar buttons.

 �Interval selection can now be done across all channels instead of just for the current channel.

 �Time intervals for invalidating waveforms can now be read in from a text file.

 �Can now optionally export unsorted timestamps as a .NEX variable.

 �Added a forward/back feature to enable easy back/forth between channels.

 �Added a ‘Slice 4’ position and feature; having four slices is handy when dealing with tetrodes.

 �Added back the View Waveform option to view only unsorted, and the ‘Do Not Use Sorted Waveforms’ option.

 �Added ability to sort the currently loaded file using the unit assignments read from a .NEX file.

 �Added ability to export waveform AD values to a text file, MATLAB or Excel.

Improvements:
 �Added new default layout for toolbars, and added more toolbar buttons.

 �n, p keys to Go To Next, Previous channel now works in the Detection view.

 �Added ability to show the frequency for each channel in the Chan Params view.

 �Text color for the 3D view can be different than the text color for the other views.

 �Moved ClustHistMax from the Control Grid to the Dot Frequency Display Parameters dialog.

 �Added a non-linear scaling of the zoom spin control, so that it steps by 0.1 for small values and by 1.0 for large values.

 �Removed pointless DSP column from Channel Parameters Grid view.

 �Display updates are now deferred while a TPL file is being applied.

 �All Grid-based views now support a ‘Select All’ right-click menu function.

 �Added option to do byte-swapping when importing binary files.

 �Expanded size of MRU file list.

 �Added ctrl-click input of centers to make it easier to define centers in the 3D view.

 �Added option in Templates view to show templates in units of Microvolts (instead of A/D counts).

 �Now remembers View Waveform settings (all/selUnits/unsorted) between channels.

 �Options in the Recalculate Principal Components dialog added to ‘Feature Calc’ options page, dialog appearing before the 
PCA recalculation is now optional.



www.plexon.com
Page 27

 �Changed default of PCA so that it uses only valid waveforms, and only points between sort start/end.

 �Minor usage improvements in the Scan view.

 �Added spin control for Outlier Threshold in the Control Grid.

 �Info view sub-tabs that list channels now have a right-click menu option to make the selected channel the current channel.

 �Fixed analog channel numbers displayed in Chan Params tab for .PLX files to be 1-based, and displayed the number of 
samples instead of the number of fragments.

 �When showing only unsorted waveforms, the Waveform display will overlay the template waveforms for existing units.

 �Various efficiency improvements and optimizations.

 �Moved PCA waveform limit from Large Files to Feature Calc property page, and onto Recalculate PCA dialog, and moved 
the remaining Large Files options into the File Import options page.

 �Added new option during ‘Save As New .PLX’ function to completely disable saving all continuous data to the .PLX file.

 �Added new option to control whether ‘Remove Outlier’ tool affects all units (as before) or only the currently 
selected unit(s).

 �When swapping or combining units and there are only two units, do not bring up dialog or requiring selected units.

Bug Fixes:
 �Fixed problem with Waveform display showing all unit templates EXCEPT the selected units. Now it only does this when 
viewing unsorted waveforms.

 �Fixed problem where strobe codes would not be properly saved during the Save As New .PLX operation when a strobe 
code representation of hexadecimal or octal was in effect.

 �Fixed bug introduced in v2.5 that causes 3D contours from .TPL files to be mis-applied. Also fixed  
potential problems with 2D contour applications when feature space ranges were different.

 �Fixed problem with Offline Sorter remembering the slice positions between channels.

 �Fixed bug where the normal colors would be used instead of the print colors when printing several views.

 Fixed bug where starting with v2.5.0 Offline Sorter would ‘collapse away’ empty units following a sort. While this is  
   useful in most cases, it makes sorting by applying a .TPL file very confusing. Disabled this feature for the Template sorting  
   algorithm.

 �Fixed problem in which file size in Globals view was not correct for some file formats.

 �Fixed bug where customizing the Features toolbar is no longer permitted, as this could lead to a crash.

 �Fixed issues with slice positions not visually lining up with the sample positions in the Waveform display.

 �Fixed problem with energy and non-linear energy display in Continuous Data view for slow channels in some file formats.

 �Fixed issue with DataWave file layout records for unused channels.

 �Fixed issue with applying .TPL files on extracted continuous channels for certain file formats (e.g. MCS).

 �Fixed problem with adjusting slice positions for some file formats (e.g. Neuralynx).

 �Fixed problem where superfluous scroll bars appeared on some Grid-based views.

 �Fixed problem that occurred when NumPointsWave changed in mid-.PLX file. A warning will now be displayed if the .PLX 
file has this problem.

 �Fixed cosmetic problem that could leave unit tolerance spin/edit controls on screen after closing a file.

 �Fixed possible problem with calculating PCA for trodal data Fixed bug that allowed crash in Scan view when >26 units 
were entered for K-Means scan.

 �Fixed broken print preview and printing the 3D Cluster view.

 �Fixed bug where when the ‘Use Projected 2D Space…’ checkbox was checked in the Sorting Options panel, the E-M-
based sorting algorithms would sometimes fail to converge due to an issue with the initial conditions at the start of the 
E-M algorithm. When this happened, the algorithm would produce no units. A new method is now used to get the initial 
condition that is less prone to this problem.

 �Fixed bug where doing a normal save on stereotrode/tetrode .PLX files that had mismatched (‘dropped’) waveforms  
could misassociate units.

 �Fixed bug to where the Save As New .PLX operation will now preserve gaps in continuous data.

 �Fixed bug to where the following operations now honor the ‘Use Range’ time range: Remove  
Outliers, Remove Short ISI, Assign Unsorted.

 Fixed problem in which the Set WaveformLimit option in batch files was being ignored.

 �Fixed some anomalies concerning erasing ‘stale’ contours from the Cluster view after certain operations.

 �Fixed issue where the suggested filename for ‘Save As New .PLX’ when working with a .PLX0 had two ‘.’s in it. Also a 
harmless but unneeded ‘cannot read file’ message box could appear when ‘Save As New .PLX’ tried to save continuous 
data channels from a .PLX0.
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Offline Sorter v2.5.0

New Features:
 �Added new E-M sorting methods, with associated options, scans, and batch commands (‘TDist’ and ‘TDist3D’ for  
new T-Distribution based sorting, and ‘set DOFMult’ to control the D.O.F. multiplier parameter for the T-Distribution 
sorting algorithm).

 �Can watch animated sorting progress, and can cancel sorting. Can cancel sorting parameter Scans and sort-all-channels 
operations also.

 �Improved unit selection allows easily selecting multiple units, which allowed a simplification of the View Waveforms 
options.

 �The selection of Features for 2D feature space is no longer independent from the features for 3D feature space – they 
share X and Y feature selections. This allows many simplifications and removed a tripping point for many users.

 �Nicer interface for batch processing, can cancel batch file execution.

 Added new PDF-based help system.

 �Added menu entries to dump Sort Summaries of all channels to PowerPoint and to the printer (or to aPDF file, if PDF 
Distiller is installed).

 �Added function to swap units.

 �Went to a more consistent, zoom-based approach to handling scaling in Continuous Data view.

 �Added automatic zoom setting when loading channels.

 �Added new batch commands for interval-based waveform invalidation.

 �Added command to invalidate all except selected waveforms (inverse of invalidate selected waveforms function).

Improvements:
 �Max Waveform Draw, Sort Type, and selected features are now persisted between Offline Sorter invocations.

 �Improved the way that the bottom bar scrolling windows behaved; can now zoom in much more.

 �Moved ‘Auto-Sort All Channels’ functions to Sort menu, also added ‘Auto-Sort All Channels Using TDist E-M’ function.

 �Changed default of show waveforms for Cluster and Continuous view to be ‘As Above’, changed various other defaults to 


